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LasKin 

Software for solid-state laser simulation. 

LasKin software is a tool for computational modeling of solid-state laser kinetics in free 

running and Q-switched modes with pulsed and CW optical pumping. The laser scheme 

has a linear configuration containing: 

– rear (HR) mirror and output coupler; 

– longitudinal or transverse pump source (collimated uniform CW pump beam or pump 

pulse with specified waveform); 

- laser element equipped with retro reflector for unabsorbed pump light placed opposite 

to the pump source; 

– optical system for changing laser beam cross-section ratio in active element and Q-switch 

("Telescope"); 

– Q-switch (passive (PQS)/active (AQS) or combination of AQS+PQS);  Q-switching  with 

variable off time and Q-switching by variable output coupling. 

General algorithm of data setting and calculations run is : 

A) Choice of an active medium (general laser scheme or Er-Yb:glass, Nd:host, Yb:host), in-
put of characteristic data (decay rates of energy levels, energy transfer parameters, ab-
sorption and emission cross sections); 

B) Setting of resonator parameters (total length, active and passive intracavity losses, 
overlap efficiency of active element excited volume with active lasing (resonator trans-
verse mode) volume, geometrical dimensions of an active element field where pump 
radiation is effectively absorbed into - e.g. conditional dimensions of an active ele-
ment); 

C) Choice of pump scheme (transverse or longitudinal), setting of a pump source total ra-
diation power, pump pulse duration, efficiency of pump radiation delivery to the active 
element (coupling efficiency). Finding  an average effective value of an active element 
pump power density with the use of data set in #A. Calculations are made allowing for 
possible partial pump radiation reflection Rp that is not absorbed at first pass through 
the active element; 

D) Active or passive Q-switch parameters settings for Q-switch operation mode; 

E) LasKin calculates lasing  within point model frame and displays a list of main output pa-
rameters and computer oscillograms of output laser power, population in the active 
media and intracavity losses .  Simulations and plotting  of output values vs. parametric 
input data (i.e. output energy vs losses, output pulse duration vs pump power etc.) is 
also available. 

F) Both input data file and calculation results  can be saved for future use. 
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Installation 

System requirements: 

Windows XP SP2 or newer, 512 Mb RAM (1 Gb recommended), 800 MHz processor . 

Net Framework 3.5 and DirectX are required. 

 

Setup procedure: 

Insert Setup Disk or download LK_setup.exe; 

Run file SETUP.EXE on this drive; 

Follow up the instructions. 

 

When the setup procedure finishes, the following files appear in the directory selected 

during installation (LasKin home directory, by default, C:\Program Files\ LasKin 5.0): 

 laskin.exe (shell file) – main program file providing end-user interface; 

 laskin.chm – current version of Help File; 

 *.cfg – configuration file for LasKin (editing is not recommended); 

 *.lmd – customized file for LasKin (editing is not recommended). 

Supplementary files: 

 *.dll – DLL's for LasKin; 

 *.lk3, *.lk4 – input data files for LasKin; 

 *.pdf – User manual files. 

Registration: 

To register a copy of LasKin software and get access to full-operation mode, please: 

1.      Select menu item Help->Register; 

2.      Send your Request code together with the purchasing information to distributor to 

obtain the Final Registration Code; 

3.      When your receive the Final Registration Code select menu item Help->Register; 

4.      Enter your Final Registration Code; 

5.      Click Ok;
 

6.      Restart the program (for working in full mode). 
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Tutorial 

Here is a quick overview of the LasKin interface. For detailed description of the program 

capabilities view Worksheets section below. 

1. Run the program. 

2. Click <Select> button (or “File->Laser Medium Select” menu item). 

3. Select laser medium in additional window (Fig. 1). For example - Nd:YAG. Click <Ok>. 
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Fig. 1 “Select laser medium” menu 

4. Set the necessary parameters in the windows (“Laser Medium”, “CONFIGURATION”, 

“PUMP”, “Q-switch”, ”Special”): 

Warning! 

After changing parameters <Apply> button enables. Click <Apply> button to confirm changing parame-

ters, otherwise all changes would be canceled.  

 – Dopant concentration and other active medium parameters can be set in “Laser medi-

um” window. 



Fig. 2. “Laser Medium” window 

 – Active medium size, cavity length and other cavity parameters can be set in 

“Configuration” window. 

Fig. 3. “Configuration” window 



– To set varying pump waveform click <Change> button in “Pump” window (Fig. 4), select 

“Varying” (Fig. 5), click <Edit pump form> and set necessary parameters (Fig. 6).  

Fig. 4 “Pump” window 

Fig. 5 “Pump waveform” window 



Fig. 6 “Pump waveform” configuration window 

– Uncheck “AQS is installed” and “PQS is installed” in “Q-switch” window (Figure 7 a, b) for 

free running mode. Check for the desired Q-switched mode: Active/Passive or Active + Pas-

sive).  

Fig. 7 a “Q-switch” window (AQS) 



Fig. 7 b “Q-switch” window (PQS) 

 – To calculate dependencies of laser performance on input parameters (output energy vs 

output coupler reflectivity, etc.) and proper optimization of used components check “Show 

dependence function” in “Optimization” window (Fig. 8). Set desirable range of the varied 

parameters. 

Fig. 8 “Optimization” window 

Warning! 

If the calculated dependence curve does not look «smooth» check temporal profile in singular points or 

change step of argument. In some cases fine changes in the temporal structure are caused by finite values 

of the lowest lasing level lifetime. For rough estimations set the values as low as possible. 

5. Click <Start> button. 



6. View result in “Preview Result” window (Fig. 9). 

Fig. 9 “Preview Result” window 

7. Double click on graph (or click <View> button) to switch to full view of the results. 

8. View Result in “Result” window (Fig. 10). 

Fig. 10 “Result” window 



9. Use the mouse to customize the graph or double click on the graph field and set neces-

sary parameters in additional “Plot Option” window (Fig. 11) for more detailed customiz-

tion.  

Fig. 11 “Plot Option” window 

10. Click <Report> button to create file with output report. 

11. Click <Save> button to save all input data (output parameters and calculation matrix 

in .*txt format and graph in *.bmp format). 

12. Close “Result” window, save intermediate input data in named file (default filename 

result.lk3) and start new simulation cycle if desired. 



Worksheets 

There are 6 main windows in the program: 

 Laser Media 

 Configuration 

 Pump 

 Q-Switch 

 Special 

 Result 
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Laser Medium 

In this window (Fig. 10) an energy levels diagram is displayed and active media parameters 

such as concentration of activator ions (N, cm-3 or atomic %), peak absorption cross section 

(σ0
p, cm2), emission cross section (σ0

e, cm2), absorption coefficient (α, cm-1), decay times (τi-

j, µs) etc. can be entered. 

Fig. 10. “Laser Medium” window 

One can find out effective value of absorption cross section (σp, cm2) while using the ab-

sorbing ions concentration (N, cm-3) and experimental value of absorption coefficient at  

pumping wavelengths range for the used active element (α, cm-1). Spectra overlap (Fig. 11) 

coefficient (ks) binds reference value of peak absorption cross section at known wave-

length (σp
0, cm2) and calculated value of effective absorption cross section for the used 

pumping source spectrum. For narrow band pump peaked at corresponding absorption 

maximum ks=1 

σp = N · α 

ks = σp / σp
0 



Fig. 11. Pump and absorption spectra overlap 

 

Configuration 

In this window (Fig. 11) the following parameters can be set: 

 active media shape (slab-like  or cylinder-like)* 

 active media dimensions: length (La, cm), width (Lb, cm) and height (Ld, cm) for the 

slab, diameter (DIA, cm) for cylinder 

 physical cavity length (Lc, *cm+) 

 output coupler reflectivity (Roc,*100%+) 

 intrinsic resonator losses (gc,*100%+) 

 active element dissipative losses (ga, cm-1), including variable losses (Fig. 12) to al-

low for  intracavity losses dynamics in pump pulse width time scale. To set variable 

losses press button next to dissipative losses field. 

 lasing and pumped area overlap efficiency (ηov) 

 magnification of intracavity telescope (TM). 

* Active media  in LasKin corresponds to the optically pumped volume 



Fig. 11. “Configuration” window 

To simulate possible changes of intracavity losses while pump pulse  is applied (thermal 

lensing, depolarization etc.,) one can set the changes by points array. It can be loaded from 

file, where Time and Losses values should be separated by space or tabulation symbol and 

each point starts at a new line. 

Fig. 12. Variable losses window 

Additional buttons for the output coupler reflectivity and amplification length of lumines-

cence photon are available for modeling of lasers operating  at secondary lasing transitions 

(like 4F3/2 — 413/2) for Nd:host lasers ) and will be discussed later. 



Pump 

Pump parameters (type of pumping scheme), pump pulse duration (τp, *µs+), pump power 

(Wp, *W+), pump wavelength (λp, *nm+), Pump coupling optics efficiency (ηc,*100%+) etc.) 

can be set in this window (Fig. 13).  

Fig. 13. “Pump” window 

LasKin uses averaged effective value of Pump flow . Details of averaging procedure and val-

ues of some additional parameters are provided in “Pump fluence averaging” window 

(Fig. 14). It can be opened with the button located next to Effective pump flow field. 

Button <Change> in Pump form field opens window (Fig. 15), where you can choose the 

waveform of the pump pulse. Available waveforms are: 

 Rectangular 

 Trapeze, where you can set the pulse rise time 

 Varying, where pump waveform can be defined by points in a similar way as were 

variable losses, described in the Configuration section above. 



Fig. 14. “Pump fluence averaging” window 

Fig. 15. “Pump waveform” window 



Q-switch 

To achieve giant laser pulses formation  Q-switches are added into laser configuration. Ac-

tive and passive Q-switches can be installed separately or simultaneously. Variable output 

coupling  mode  is  also available with LasKin. It is realized as a type of active Q-switching. 

Q-switch window with installed active Q-switch is shown below (Fig. 16). 

Fig. 16. Active Q-switch window . 

 Active Q-switch configurations available with LasKin 5 are listed below: 

 AQS  with  round-trip  Q-switch losses = (1-Tsh). In the Q-switch Type window it is 

called EO Q-switch type. An example of such a device is electro-optic Q-switch in 

quarter wave configuration. The value Tsh corresponds to transmission of  light 

throughout polarizer, Pockels or Kerr Cell, retardation plate and backwards. 

 AQS  with full intracavity round-trip losses  depending on squared value of  current 

Q-switch transmission  (1-Tsh2). Examples of such type devices are the acousto-optic 

and  FTIR* shutters and  electo-optical Q-switches in half wave configuration. 

 AQS in cavity with variable output coupling (VOC Q-switch mode).  

* Q-switch based on Frustrated Total Internal Reflection 



a)         b) 

Fig. 17. a) VOC-I   b) VOC-II scheme 

Q-Switch HR Mirror

HR Mirror

Output

Q-Switch

HR Mirror

Output

HR Mirror

Variable Output Coupling  Q-switch mode. 

In Q-Switch window one can also choose  variable output coupling mode (VOCI,II-modes). 

This modes  mean to simulate situations when output coupling changes while lasing builds 

up. Equivalent output coupler  consists of  Q-Switch  cell with variable transmission Tsh . It 

divides beam into  transmitted and reflected parts  with the ratio of Tsh /(1-Tsh )  (Fig. 17).  

Cavity dumping mode is a particular case of VOC, with  Tsh
0  =1,  Tsh

max  =0  for VOC-I 

scheme  and  Tsh
0  =0  , Tsh

max  =1  for VOC-II scheme . 



Available temporal control modes of Q-switching are : 

 Single – Q-switch activated once 

 Frequency – Q-switch activated several times with defined period (frequency) 

 Linear – Q-switch activated several times with defined period/frequency and Q-

switch off-time changes linearly (defined by formula Toff = a · (t - ts) + b, where co-

efficients a and b are defined by user). 

Active Q-switch transmission function  with full set of used  parameters is shown in Fig.18: 

Fig. 18. Active Q-switch transmission function 



Fig. 19. Passive Q-switch window. 

Passive Q-switch 

Passive Q-switches are used in lasers as light controlled shutters ,PQS1-5-. Window for 

passive Q-switch PQS (Fig. 19) shows  4-level energy diagram for saturable absorber 

typical  for  widely used  PQS  based on  Cr4+: HOST  crystals and allows for the following  

parameter settings: 

 Geometrical thickness of the used PQS (LPQS) *cm+ 

 refractive index (nQS) 

 Initial transmission of the used PQS: 

 

Where  Tsh
D -  passive Q-switch transmission caused by nonresonant dissipative losses 

gs (nonresonant absorption and scattering in the used PQS volume). By default  

Tsh
D = 0 and this type of loss is accounted for as general intracavity dissipative losses 

(see window “Configuration”), 

 is  a resonant part of the PQS transmission for low average intra 

cavity intensity,  Is = I+ +  I-  (summarized direct and backward photon flows I+ , I-) 

 Decay time—decay time   

 Cross section— absorption cross section  for the transition from ground state  gs 

 Figure of merit (or PQS contrast if Tsh
D = 0) FOM = gs/e = ln(TPQS

0) / ln(TPQS) (at sat-

uration fluence) 
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Special 

In this window one can choose to calculate a dependence of selected output parameter on 

a certain input parameter. In order to use this option, activate checkbox “Show depend-

ence function”. Select desired output parameter at “Value”, input parameter  at “Depends 

on”. Set the range for the input parameter from the list and the number of points to calcu-

late. 

Fig. 20. “Special” window 



Result 

When all necessary parameters are set press Start button to start calculation. After com-

pleting, “Preview result” window is displayed (Fig. 21) . It contains calculated table of laser 

output parameters and general view of calculated lasing generation dynamics graphic (blue 

line) and inversion dynamics (red line).  

Fig. 21. “Preview result” window 

By clicking on “View” button or double click on plot field  “Result” window (Fig. 22) can be 

opened. There you can see detailed plot, zoom it, switch inversion plot to losses, Q-switch 

transmission or pump plot by clicking corresponding buttons, save calculated results and 

create report in Microsoft Word . 

In “Result” window press <Save> to save matrix file with detailed calculated data, including 

temporal behavior of population, Passive Q-Switch transmission (if installed) and laser gen-

eration. 

To build graphs in Origin: 

Open Origin 

Press File->Import->Single ASCII 

In opened dialogue window select *.txt file type and open your matrix file. 



Fig. 22. “Result” window  

Fig. 23 “Plot Option” window

Plot in “Result” window is provided with  measure cursors used to measure amplitudes 

and time intervals in the plot. 

When your mouse is placed over the plot you can change x-axes values range. One can 

drag plot or use mouse wheel to zoom over x-axis. Click <Option> button or double click on 

the plot field to open “Plot Option” window (Fig. 23) where you can set desired x, y values 

range. 



Additional features 

In some cases lasing ions have a number of possible lasing transitions from metastable up-

per level to existing manifold of lower levels. The transitions differ in oscillator power (or 

value of stimulated emission cross section) and fluorescence  wavelength. The strongest 

transition is called Main Transition. Lasing at the main transition wavelength is a winner in 

a competition for exited centers.    

Secondary transitions  are weaker in oscillator power. Lasing at these transitions takes 

place  if selective losses suppress lasing at main transition.  LasKin permits to evaluate pos-

sible competitive lasing for some simple cases.  

Fig. 23. Nd:host energy diagram with competitive lasing transactions 

For instance Nd:host lasers  can generate at main lasing transition 4F3/2 level to 4I11/2, 

λ~1.06 µm) and two secondary  ones ( 4F3/2 -> sublevels 4I13/2,  at  λ~1.3 µm and λ~1.4 µm). 

To suppress lasing at main wavelength with introduced selective losses (Fig. 24 a) click the 

button next to Reflectivity of output coupler field in “Configuration” window. Even with 

suppressed generation superluminescence at competitive wavelength can significantly 

affect lasing efficiency. In order to properly consider superluminescence in calculation after 

active media dimensions been set click button next to Amplification length of superlumi-

nescenced photon field. In opened window (Fig. 24 b) set the number for statistical calcu-

lation (bigger number – more accurate calculation, default value is usually enough) and 

press calculate. 
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      a)         b) 

Fig. 24. Selective losses (a) and Superluminescence amplification length calculation (b)  

windows 



Amplifier 

For Nd:Host laser medium calculation of single pass and multi-pass amplifiers is available in 

LasKin 5. Scheme of circular multi-pass  amplifier (number of trips more than 1 ) is shown 

in  Fig. 25.  It is a multi-pass ring scheme with variable transmission for output radiation at 

mirror M1 that serves as a beam splitter (polarizer, for instance). In this case a Pockels Cell  

installed  after the amplifier can  work as a variable retardation wave plate. It provides de-

sirable dividing coefficient at polarizer -  a ratio  between  the system output and the por-

tion returned back to enter the pumped active media for the next pass. Phase shift  and  

corresponding M1 transmission can be switched  on/off  or  controlled  with desirable algo-

rithm by external optical or electrical signal including negative or positive feedbacks.   

Fig. 25. Multi-pass ring amplifier scheme 

In the “Amplifier” window (Fig. 26 )  one can set the length of full optical pass throughout 

the amplifier system. Parameters of pumped active element can be set in “Configuration” 

and “Laser Media” windows, as you do for Lasing calculation. For incident pulse you can 

set its energy, duration and choose waveform (Gaussian or Sinc2). To calculate multi-pass 

mode activate “Multi-pass” checkbox and press “Define”. In opened window (Fig. 26) you 

can set number of passes and transmission of M1 for each pass. 

Fig. 26. “Amplifier” window and Amplifier multi-pass parameters window. 
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Fig. 27. Warning message. 

When all parameters are set, press OK in “Amplifier output mirror transparency” and 

“Amplifier” window and press Start. After calculation “Amplifier result“ window (Fig. 28) 

with waveform and calculated parameters of input and output pulses will open. 

 

One can  also load multi-pass parameters from file. File should contain transmission value 

for each pass separated by space or tabulation symbol.  

Note:  In multi-pass mode amplifier length should be at least 3 times longer than pulse 

length (pulse width x light velocity), otherwise pulse of different passes will overlap, which 

can lead to unreliable results. If this condition was not met you will get a Warning message 

(Fig. 27).  

Fig. 28. “Amplifier results” window 



Kinetic diagram, model and simulation 

 

In this chapter general 4-level scheme with possible resonant transitions from sensitizer to 

lasing ions and for exited state absorption is described. 

 

Kinetic diagram: 

Fig. 29. Energy diagram of 7-level general lasing scheme. 
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Kinetic model of 4-level general lasing scheme with sensitizer and exited state 

absorption evaluation 

Balance equation for absorption, transfer and relaxation processes that is 

shown in the energy diagram, can be written as follows: 

Where: 

 

 

Ni — population of working ions level i *cm-3+; 

N`i — population of sensitizer ions level i *cm-3+; 

Nsion — population of sensitizer ion *cm-3+; 

a — pump absorption coefficient *cm-1+; 

σpump  — exited state pump absorption cross section *cm2+; 

Wp — pump power *W+; 
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Lp — pumped length *cm+; 

V — active media volume *cm3+; 

Epph — pump photon energy; 

k — energy transfer parameter; 

A0 — relative coefficient of energy back transfer  from working ion to sensitizer 

ion; 

gi-j — decay rate from level I to level j *s-1+; 

I — lasing photon density *photons/s×cm2+; 

σe — emission cross section of lasing transition; 

m0 — degeneracy parameter; 

σlas_abs — exited state lasing absorption cross section *cm2+; 

La  — length of active media *cm+; 

Lc_opt — optical length of resonator *cm+; 

vc — light velocity *cm/s+; 

S0 — initial luminescence density; 

τc — intracavity photons lifetime 

For linear resonator scheme 

 

; 

 

 

Roc — reflectivity of output coupler; 

Tsh — Q-switch transmission; 

gc — intrinsic resonator losses; 

ga — active element dissipative losses *cm-1+. 

aacshoc LggtTR
c
v

optc
L

с 





2))1()(ln(

1
2

_
2





References: 

 

L1. Koechner .Solid-State Laser Engineering.,  Berlin Heidelberg NY,  Springer-Verlag, 1999. 747 p. 

L2. Ifflaender R. Solid-state lasers for materials processing: fundamental relations. Berlin Heidelberg NY, 

Springer-Verlag, 1998. 368 p. 

L3. Kalisky J. The Physics and Engineering of Solid State Lasers. Bellingham, Washington, SPIE, 2009. 

203 p. 

L4. Weber M.J. Handbook of lasers, SRC Press,LLC,2001,1186 p. 

L5.  F.Traeger Springer Handbook of Lasers and Optics Springer-Verlag, 2007, 247 p. 

 

 

PQ1 M.Hercher, “An analysis of saturable absorbers,” Appl.Optics., vol.6, pp.947-954,1967 

PQ2 J.J.Degnan, “Optimisation of passively Q-switched lasers,” IEEE J.Quantum Electron., 

vol.31, pp.1890-1901,1995 

PQ4 G. Xiao,M.Bass,”A generalized model for passively Q-switched lasers including excit-

ed state absorption in the saturable absorber,”   IEEE J.Quantum Electron., vol.33, 

NO1,pp.41-44,1997 

PQ4  Y.Kalisky,  “Cr4+-doped crystals - their use as lasers and passive Q-switches”, Progress 

in Quantum Electronics 28 ( 2004), pp. 249-303 

PQ5 .  Russian Standard “ГОСТ P50737-95” goo.gl/0Mj1C 

http://goo.gl/0Mj1C



